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Experimental Design:  The ImageStream system quantifies the intensity, location, and 
distribution of fluorescent signals within tens of thousands of cells per sample.  It can 
perform most flow cytometric assays, but the best applications take advantage of the 
technology’s imaging capabilities to discriminate subtle morphologic or signal distribution 
changes within individual cells and cell populations. 
 
1. Choice of Cell Type: The particle size should be less than 120um using 20x 

magnification, 60um using 40x, and 40um using 60x. Images below are THP1 cells 
(~15um diameter) labeled with FITC NFkB and Draq5 displayed at each magnification.   
 
 
 
 
 

 
 
 
 
 
 
 
 
2. Final Sample Concentration and Volume:   At least 1 million cells in 50 uL (2x107 

cells/ml) in PBS/2%FBS in a 1.5mL siliconized microcentrifuge tube.  Will run ~400 cells 
per second on low speed.  
 

3. Protocols: In general, any established labeling protocol used for flow cytometry will 
work with the ImageStream (see Current Protocols in Cytometry for general labeling 
techniques).  Staining on ice in the presence of 0.1% Na-azide when possible will reduce 
non-specific capping of antibody. Use siliconized polypropylene tubes when possible. 
 

4. Choice of Fluorochromes:  Choose fluorochromes that are excited by the lasers in 
your ImageStream (405,488,642nm are most common). Use the chart on p.3 or look 
online for a spectra viewer that will help you plan which dyes will work the best. 

 
5. Compensation:  Have a sample of cells each labeled with a single-color for each 

fluorochrome used (i.e. FITC only cells, PE only cells, etc.).   
 

6. Cell Aggregation:  Minimize aggregation problems by straining the sample through a 
70um nylon mesh strainer, or by using an anti-clumping buffer such as EDTA or 
Accumax prior to fixation. 

 
7. Fixation: If fixation is desired, fix cells with 1% PFA on ice for 20 min. 
 
8. Number of samples: No more than 30 total for feasibility experiments.  Please limit 

the samples to the following; Positive and Negative biologic controls, compensation 
controls, and experiment samples.
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9. Brightness of Stain and Stain Balancing:  Quantifying the location and distribution of 

signals in an image is a demanding task that requires optimized labeling. Below are a 
few suggestions to help design the experiment: 

• Try to achieve at least a full log shift in fluorescence, as measured by FACS. 
• Use the brightest dye for the antigen with the smallest copy number. 
• The brightness of probes can be independently controlled by changing the laser 

power. However, data quality is enhanced when the brightness levels of all 
probes excited off a single laser are balanced to within a log of each other.  Probe 
balancing avoids the saturation of bright stains when they are combined with dim 
stains in the same sample. 

 
10. Shipping recommendations: 

•••• Include the data acquisition form and data that verifies the experiment 
worked. 

•••• Samples must be fixed and non-pathogenic. 
•••• Wrap sample tubes in Parafilm. 
•••• Insulate by placing in 15ml conical rack with Styrofoam lid. Pack in Styrofoam 

lined shipping box with refrigerant packs and paper. For winter delivery, use 
room temperature packs to prevent freezing of sample.  For summer delivery use 
frozen packs. 

•••• Label outside of box ‘Do Not Freeze’. 
•••• Email the package tracking number to your Amnis contact person. 

 
11. International Shipments 
To ship non-viable (fixed) material internationally to Amnis, a written statement for US 
Customs and Border Protection, Department of Homeland Security must accompany the 
shipment. This written statement must: 

• Be addressed to; US Customs and Border Protection, Department of Homeland 
Security. 

• Be an original copy on institutional letterhead signed by the laboratory worker 
responsible for preparing the samples. 

• Identify the material and name of the species from which the material was derived. 
• state that the animals from which the material was derived: 

a. have not been exposed to, or inoculated with, any livestock or poultry disease 
agents exotic to the United States, and  

b. did not originate from a facility where work with exotic disease agents affecting 
livestock or avian species is conducted 

• State that the material is non-viable 
• Be placed in an envelope addressed to ‘US Customs and Border Protection, 

Department of Homeland Security’ and attached to the outside of the shipping box. 
 
 
Shipping Address: 
 
MilliporeSigma 
Amnis Corporation 
645 Elliott Avenue West, Suite 100 
Seattle WA  98119 
Pn: (855) 240-8045 
Fx: (206) 576-6895 
Email : applicationsupport@amnis.com 
            TUwww.emdmillipore.com/amnisUT 

Amnis Support: 1.800.730.7147     www.emdmillipore.com/amnis 
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BF-Ch01

FITC

PE

PE-TxRed

SSC-Ch06

BV421 or
DAPI

BF-Ch09

AF647

APC-Cy7

suggested “ideal” panel design



20x / 0.5 NA 

128 µm FOV (width of field) 

1 µm-square pixel area 

8 µm depth of field 
 

40x / 0.75 NA 

64 µm FOV (width of field) 

0.25 µm-square pixel area 

4 µm depth of field 
 

60x / 0.9 NA 

40 µm FOV (width of field) 

0.1 µm-square pixel area 

2.5 µm depth of field 
 

   

 
   

optimal concentration: 1 million cells per 50 µl 
minimum volume: 20 µl 

400 cells/sec = 24,000 cells/min 
200 cells/sec = 12,000 cells/min 
100 cells/sec = 6,000 cells/min 
50 cells/sec = 3,000 cells/min 
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INSPIRE® Quick Start Guide  
 

 
Amnis® ImageStream®X MK II Operation 

  
Operation of the ImageStream®X Mk II with software map on the reverse side:  
 
1. Power up the system (1 instrument, 2 large computer, 3 small computer)  

  
2. Launch the ISX application.   

  
3. Check to be sure the buffer containers are full and the waste tank is empty.  

  
4. Select Startup and the instrument will load sheath in ~14min. “Calibrate with Assist” Checked.  

 

5. Or under the Instrument/ Calibrate view, press Start all calibrations and tests.  
 

6. When all tests pass, ASSIST light is green and the system is ready to run. Close view.  
  

7. Select file and load default template or an experiment template from the File menu.   
  

8. Press Load and, load an aliquot of a sample with each fluorochrome present.  
  

9. Under Illumination, turn on the appropriate lasers for each fluorochrome.   
  

10. Adjust the laser power to maximize brightness and prevent saturation.  
  

11. Create dot plots and regions to identify the cells to collect, or collect all events. Typically Ch1_Area 
vs. Ch1_Aspect Ratio is used to eliminate SpeedBeads and debris, and collect cells.   
  

12. Set the acquisition parameters: file name, destination, number of events and region to collect.  
  

13. If needed save .fcs files as well as the image based .rif file.  
  

14. Compensate data if needed. Data is normally compensated during analysis, however you can 
select the compensation drop down and load matrix, or create a new one.  
a. In the wizard’s directory, select the compensation wizard.  
b. Load the compensation control sample, press next, and verify the channel is correct, next.  
c. Verify the system finds the correct channel, press next.  
d. Set the acquisition file name, destination/ population to save, press acquire.   
e. Press next, and the wizard will cycle back to step B.  
f. Repeat steps B through E for each compensation control sample. Press exit to save matrix.  

 

15. To manually collect compensation controls, turn off Brightfield and SSC, verify all channels are 
on, and collect 1000 All events (or suitable region) for each compensation control sample.  
 

16. Continue collecting all experiment files. (In general brightfield will be in Ch1 and 9, SSC ~5 mW in 
Ch6, and the cells to collect R1 using brightfield area vs. aspect ratio to identify single cells).  
 

17. Save an experiment template by selecting Save Template from the File menu.   
 

18. Shut the system off by pressing the Shutdown button. The system will sterilize itself in ~40 min.  
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Analysis and Data Management 
  
Opening Data Files: There are three types of image file: Raw Image File (.rif), Compensated Image 
File (.cif), and Data Analysis File (.daf). FCS files can be analyzed in IDEAS or third party analysis 
software and will contain the feature data without the images. 

 
Opening files using the Start Analysis 

1. Launch IDEAS®.  

 

2. Click Start Analysis, and browse for the appropriate data file. Or use “File” “Open” and choose a 
.rif, .cif, (skip to step 4) or .daf (skip to step 6). File extensions need to be visible in windows to 
know what the file type is. 
 

3. Browse for an existing compensation matrix (.ctm file) or create a new one by clicking New Matrix 
and follow the steps outlined in the compensation QS guide. 
 

4. Select an analysis template (.ast file) or a .daf with the analysis you wish to apply. If no template is 
chosen the default template will be used.  
 

5. Select the active channels used in the experiment, and the Image Gallery Display properties will 
be applied to the images. They can be manually adjusted following the reporting QS guide. 
 

6. Select the appropriate wizard for your application and follow the steps to completion. Basic 
Immunophenotyping can be done using the “Begin Analysis” wizard. Use the “feature finder” 
wizard if your application is not in the default list. 
 

7. To add additional analysis use the histogram and dot plot icons in the tool bar, or select Guided 
analysis and choose a building block. 
 

8. Add additional Masks as needed. (Analysis / Masks / New / Function). 
 

9. Add additional Features as needed. (Analysis / Features / New). 
 

10. When the analysis is complete save the data analysis file (.daf) and analysis temple (.ast) using the 
options in the file drop down list. This analysis can be applied to any data file following the steps 
above, or choosing “file” then “open” and applying the .ast and .ctm files. 
 

11. When the wizard is complete, validate the regions by opening the control files using the saved 
analysis template and compensation matrix. Also verify the data in the statistics report under 
“reports” and “define statistics report”. 
 

12. To batch process additional files, select tools/ batch data files and refer to the Batching Multiple 
Files QS guide 3. 
 

13. To report the data, right click plots or images, and chose copy to clipboard. You can then paste the 
data into any third party reporting software.  
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To save an analysis template file:  

1. From the File drop down option, Select Save As Template File (.ast).  

2. Enter the name of the analysis template to save. 

3. Click Save. Any file can now be opened and analyzed using this template. 

 
To batch process data files:  

1. From the Tools menu, select Batch data files.  

2. Click Add Batch.  

3. Click Add Files, and ctrl select all the data files in the experiment.   

4. Select the compensation and analysis template to use. 

5. Click OK, and when all critical batches have been added, select Submit Batch, to start the batch. 

 
To merge Raw Image Files:  

1. From the Tools menu, select Merge .rif Files. The Merge .rif Files screen appears.  

2. Click Add Files, and Ctrl-select the .rif files to merge.  

3. Click OK and name the file with a unique file name.   

4. Click Save.  

 
To create a new data file from populations:  

1. From the Tools menu, select Create Data File from Population.  

2. Check the Raw Image File (.rif) box to create a .rif file and click the browse button to select a 
name. Check the Compensated Image File (.cif) box to create a .cif.   

3. Check the desired populations in the Select population list, and hit OK.  

 
To Export Image and Feature Data for multiple files:  

1. Under the Tools menu, select the type and format of the data to export.  

2. To export Feature data, select export features, for images select export .tif Images.  

3. Select the population and features to export.  

4. Select Add files, and Ctrl-select the data files to export. 

5. Chose the format and population of data to export (i.e. FCS), and press OK.   

 
File Structure Overview (.rif, .cif, .daf)  

 
 
 

2.) Open a raw data file .rif 

3.) Navigate to a 
compensation matrix. 

4.) Navigate to an 
analysis template. 

12.) Once analysis is 
validated Batch process 
experiment, and review 
statistics report.  
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Compensation 
  
IDEAS® uses a wizard to automatically calculate a compensation matrix for your experiment. During 
data acquisition a file of between 500 and 1000 positively-stained events should be collected from a 
single color control sample for each fluorochrome in the experiment. Compensation control files should 
be collected with all channels active and brightfield and SSC turned off. Each compensation file is 
then loaded into IDEAS and used to measure the spectral crosstalk of each fluorochrome into each 
channel, and is applied to the experiment data when the file is opened or the experiment is batch 
processed.  

 
To create a compensation matrix: 

1. Select New Matrix when opening a .rif, or from the IDEAS toolbar select Compensation then 
Create New Matrix. 

2. Click Add Files and control-select the appropriate –noBF control files. One for each 
fluorochrome in the experiment. Click Next to load the files. 

3. Verify the active channels used in the experiment and click next. 

4. IDEAS will automatically identify the single color positive cells, create adjacent channel 
intensity dot plots, and auto-generate a compensation matrix.  Matrix values with greater than 
1% error are flagged red. If all values are black click Finish. 

 
Validate the compensation matrix: 

5. If some values are flagged red, optimize the matrix.  To do this: 

a. Double-click the red value in the matrix.  The Matrix Coefficient Intensity Plot is displayed. 

b. If the green line does not fit the data points on the plot, click                                 

c. Use a region tool       to select a new positive population that excludes any outliers. 

6. Assign the new population to its channel using the appropriate drop down list. 

7. A new matrix is calculated automatically and can be re-evaluated by double-clicking each cell in 
the matrix. Continue this process to obtain the lowest coefficient error value possible. 

8. To view images with the applied matrix, select Preview Images. Double-click an image and 
IDEAS will display the compensated version of the image in the gallery window. 

a. If crosstalk images have black areas, the fluorochrome is overcompensated, and the 
corresponding matrix values should be manually reduced. 

b.  If crosstalk images have bright areas, the matrix is undercompensated, and the 
corresponding matrix values should be manually increased. Repeat until crosstalk 
imagery is as close to background as possible and close the image gallery. 

9. Click Finish, and save the compensation matrix 
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Troubleshooting Compensation 
 
Sometimes an applied matrix produces poorly compensated data. This can happen for a number of 
reasons including saturation, autofluorescence, or using the wrong population. Ideas lets you manually 
adjust the matrix using this method.  
 
To troubleshoot and repair a compensation matrix: 

1. Open the poorly compensated (comp) data and use the tagging tool       to create a training set of 
poorly compensated events. Include blanks and cover a range of intensities. 

2. Save the training data by selecting tools, then create data file from population. 

3. Create and save a Comp Template or use the template in 9 color comp training data folder; 

a. Set the image gallery display properties         for each channel from 0 to 150. 

b. Create adjacent channel Raw Max Pixel dot plots and gate out saturated events. 

c. Create adjacent channel Intensity dot plots using the non-saturated events. 

d. Save this template as an .ast file and use for future compensation troubleshooting. 

4. Open the “training data set” with the “compensation” template and apply the current incorrect matrix. 

5. Identify the matrix values that need adjusting using the dot plots and images: 

a. Under-compensation (crosstalk coefficient is too low): 

i. Plots: Single color positive population curves into the crosstalk channel.  

ii. Images: the crosstalk channel contains an apparent fluorescent mirror-image. 

b. Over-compensation (crosstalk coefficient is too high): 

i. Plots: Single color positive population curves off the plot. 

ii. Images: the crosstalk channel contains dark spots matching the bright spots in peak channel. 

6. Go to the Compensation dropdown, select View Edit Matrix. 

7. Manually change the incorrect matrix values from step5. Start with changes of ~.1 or ~.05. 

8. Save the new matrix. 

9. Open the “training data set” (step 1) using the “compensation” template (step 3), and apply the new 
compensation matrix (step 8). 

10. Repeat this process using smaller and smaller increments as you refine the matrix. Continue until 
the data is properly compensated.  

11. Save the new matrix by selecting OK, apply a unique name and then click Save. 

12. Once the matrix is corrected and saved it can be used for any applicable data file. 

 

 

 

Hand tag training cells and 
save as small .rif population  

When compensation looks 
correct, apply to whole data 
file and validate…  
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Feature Finder Wizard 
 

The Feature Finder wizard is used to analyze data outside of the core wizard set, to test novel 
masks/features, and assess existing analysis. It’s applicable to any data set and works by guiding the 
user through the process of hand tagging two morphologies, identifying critical feature categories, then 
using the ratio of discrimination (Rd) to asses which of the tested features best separates the two cell 
types. In general Rd values greater than 2 have excellent separation power, between 1.5 and 2 is 
reasonable and below 1.2 is little separation.  
  
Identify Lobed vs Round nuclei: 
Use a data file with both truth populations (control files may need to be merged before starting the 
wizard). This wizard only works for 2 populations, if more populations are needed multiple rounds of the 
wizard should be used. In the example below, we will find a feature to distinguish lobed vs round nuclei 
in human PBMCs.  
 

1. Follow the wizard and identify the key parent population 1. Focused cells 2. Single events 3. 
Intensity plots (if needed). Manually create new masks and features as needed. 

 
2. Assign truth populations by manually tagging 10-20 similar cells for each morphology. Focus 

on critical morphology (e.g. a range of lobed nuclei for one set, and round for the other). 

 
 
 
 
 

3. Select channels and features. To reduce errors use only critical channels, and features. (Ex. 
Use DAPI shape, size and texture to focus on nuclear shape, and omit surface markers and 
intensity so surface phenotype and DNA content don’t obscure the shape analysis). This can be 
done for all features, or to test two or three features or masks select only those few features.  
 

4. IDEAS® calculates new masks and features when processing the data. See p.2 for complete 
list.  
 

5. Review results. Refine truth populations and features as needed. Verify the feature identified 
makes sense for your application by reading the feature definition in the IDEAS manual (F1). 
Refine and repeat the process if necessary.  
 

 
 

 
 
 
 
 
 
 
 
 

Population 1: 

Lobed 
Population 2: 
Round 

Rd>2=excellent separation  
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6. Features automatically calculated by IDEAS in addition to the 86 base features. 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7. Rd is calculated using Fisher’s Discriminant Ratio, for each feature in IDEAS where features 
with the highest Rd values have the best discrimination power. This method automatically 
compares up to 2000 features at once. 

 
Rd = Signal / Noise  
Rd = (Mean1 – Mean2) / (SD1 + SD2) 
 
 

 

Feature 

Category

Feature name Mask used

Location Location Features

Delta Centroid XY channel mask

Texture Texture features

Contrast Morphology, Object

H Texture Features Channel mask

Modulation Morphology, Object

Spot Count Channel mask

Std Dev Morphology, Object

Signal 

Strength

Signal Strength Features

Intensity Morphology, Object, 

Threshold 30,50,70 %

Feature 

Category

Feature name Mask used

Shape Shape Features

Aspect Ratio Object

Circularity Object

Compactness

Elongatedness Object

Lobe Count

Shape Ratio Object

Symmetry 2, 3, 4

Size Size-based Features

Area Object, Threshold 

30,50,70 %

Height Object

Length Object

Major Axis and Minor Axis Object

Perimeter Object, Threshold 

30,50,70 %

Thickness Max Object

Thickness Min Object

Width Object
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Batch Processing Analysis 
 

Batch processing allows you to automatically compensate and analyze a group of files with one analysis 
template and compensation matrix. IDEAS® will output .cifs and .dafs as well as a statistics table of 
relevant data defined in the statistics template. 

To perform batch processing:  

1. Once the analysis is complete and verified, close all open data files and launch IDEAS. 
2. Under the Tools menu select batch data files. 
3. Select Add Batch. 
4. Select Add Files and control select files to be batch processed. You can batch .rifs, .cifs or 

.dafs. 
5. If data is not already compensated, browse for and select the compensation matrix to be 

applied.  
6. Browse for and select the template to apply to the batched data. 
7. For multiple batched data sets, you can apply a file suffix to prevent overwriting previous 

batches, however to simplify the directory it’s better to overwrite existing files. 
8. Select OK. 
9. To begin a single batch, chose submit batches, or to add additional experiments select Add 

Batch. 
10. When all the batches are queued up select Submit Batches and IDEAS will begin processing 

the data. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.) Select Add Files and 
control-select the data 
files to batch. 
 

 
2.) Select a compensation 

matrix (if needed). 
 

3.) Select a template. 
 

4.) If needed, Que up 
multiple experiments to 
batch. 
 

5.) Once all experiments are 
defined, select Submit 
Batches. 
 
 
 
 
 
 

6.) Select OK and then 
Submit Batches 

1 

3 

2 
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Statistics Batching 
 
Statistics batching is used to generate a report for analyzed data sets without the need to actively 
open every data file. First a template is created containing the statistics that will show up in the 
report. Next the template is applied to multiple data files, and a text file with the pertinent statistics is 
created. This text file can then be opened in excel and tables and charts can be generated. 
 
To generate a statistic report template:  

  
1. From the reports menu select Define Statistics Report.   

2. Select Add Column. 

3. Ctrl-select the statistics you want to use in the report.  

4. Select the population and for some statistics, the feature used for that statistic.  

5. Select Add Statistics. 

6. Select Close when finished adding statistics. 

7. To edit the column name, select the column and type a new name.  

8. To edit the report title, enter a new name. 

9. Select OK and save the analysis template using file / save as.  

10. To generate the statistics report, follow the steps below or batch process the data. 

 
To generate a statistics report:  
 
1. Select Generate Statistics Report from the Report drop down menu. 

2. Enter a report title and navigate to a .daf file containing the statistic report template.  

3. Select add files, and Ctrl-Select the saved .dafs you wish to include in the stats report.  

4. To order how stats appear in the report Ctrl-click in the order you wish, then right click and 

select “move here”.  

5. Click OK, and agree to save and close the open data file if need be.  

6. IDEAS will quickly go into each data file and extract the relevant statistics, and generate a 

statistics table as a text file.  

7. To view the data, right click the .txt file.  

8. Choose open with, and select Microsoft Excel.  

a. Alternatively, open Microsoft Excel and navigate to the .txt file, or drag it into a blank 

notebook. Excel will automatically delimit the data 

9. The new statistic table will open in Excel and allow you to create new tables and graphs. 
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Reporting 
 

Reporting with IDEAS® is centered on Right-Click, copy to the clipboard and paste into reporting 
software like Word. This works for image galleries, single images, plots, and statistics. Using the print 
screen option can facilitate rapid reporting of single data files. FCS files from IDEAS can be analyzed in 
any third party software (like FlowJo) to generate plots. FCSexpress w/ imaging allows both images 
and plots to be processed for multiple data files.  

Reporting images and setting the Image Gallery Display Settings: 
1. Select the gallery display icon.  
2. Select the channel to adjust. Edit the name and color as needed. 
3. Optimize the image contrast for each channel: The grey histogram displays the frequency of pixels 

at a given value between 0 and 4095 (12bit) in the raw image. IDEAS will display and print images 
on a scale between 0 and 255 (8bit). The green lines show how the software will convert raw 12 bit 
data to display at 8bits.  
a.) Click on the left vertical green line and set to the left edge of the grey histogram. This sets the 

background limit, and should be at the dimmest pixel value in the image or slightly inside for 
black backgrounds. 

b.) Click on the right vertical green line and set to the right edge of the grey histogram. This sets 
the display saturation limit and should be at the brightest pixel in the image.  

c.) The dashed green line shows the look up table used to display the raw pixel data within the 
new boundaries. It can be adjusted, but should be set as a linear curve. 

4. Create composite overlays. Select the composite tab and working left to right, select new, add 
image /image to overlay /add image again /add additional images. 

5. Create a gallery view: Select the view tab, and working left to right, select add column, chose 
channel or composite images, masks, and feature values to display in the new view.  

6. Use the hand tag tool to select images for your figure, save them as a population and display in 
the image gallery. Select images that display well together or adjust contrast settings for each cell.  

7. Right-click and select copy/save gallery. Edit display to include measurement tool, feature values, 
object number, channel names and paste into reporting software.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4 6 1 

3a 

3b 

5 
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Reporting 
Reporting plots:  

1. Right click on plot and select Graph Properties. Edit parent population, features, scaling, or 
density plot as needed. Intensity plots scale between -1000 and 10^7. 

2.  Select the Statistics icon, and add remove statistics. 
3. Adjust regions as needed. 
4. Right click on plot and select Copy/Save Graph… edit size, fonts, options, white / black 

background and include or remove statistics.  
5. Save to clip board and paste into reporting software.  

 
Reporting statistics:  

1. Individual plot stats: Right click on plot and select export stats to clipboard.  
2. Sample stats: In the workspace toolbar select stats, right click to edit and copy. 
3. Feature values: In the workspace toolbar select table, right click to edit and copy. 
4. Experiment stats: Select the Reports dropdown / generate statistics report. 

a. Add each .daf data file to include. 
b. Select OK and IDEAS will compile a .txt file with all the stats in the template in the 

experiment directory. 
c. Open the new .txt file in third party statistics software like excel. 

 
Create FCS files and export feature values:  

1. Select Tools / Export Feature Values. 
2. Select Add Files and ctrl-select each data file to export. 
3. Choose export to clipboard, .txt, or .fcs format. 
4. Select the features to export and press OK. 

 
Export tif. images:  

1. Select Tools / Export .tif Images. 
2. Select the population to export. For individual cells, use the hand tag tool to create a 

population of a single cell.  
3. Select the channels to export 
4. Choose the .tif format. 
5. Press OK and IDEAS will export .tif files for each channel and image in the selected population.  

 
Histogram overlays in IDEAS:  

1. Select Tools / merge .cif. 
2. Ctrl-select the data files to overlay. IDEAS generates one large combined .cif. 
3. Open the merged .cif in the experiment template. 
4. Create the populations to overlay for each sample in the merged data file. 
5. Create a histogram, and in the histogram properties, Ctrl-select each population to overlay.  

 
Histogram overlays in Word:  

1. Copy Paste each histogram into Word, plot properties must be identical.  
2. In Word, select the top plot, got to the “Picture” tab, select “color”, “set transparent color” and 

use the eye dropper to click on the plot background.  
3. Repeat for each histogram making each plot below it visible. 
4. Stack the histograms by Ctrl-selecting each plot, and in the “Picture” tab, align center, align 

middle, then group to create a single overlaid histogram 

 


